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Chapter 1 — General Information

1-1 Introduction
easyMap Tools is a PC based map preparation utility for Anritsu Spectrum Analyzers with Interference 
Analysis (Option 25) or Coverage Mapping (Option 431) capabilities. The easyMap Tools utilities prepare 
geo-referenced maps and building floor plans for use by Anritsu Handheld Spectrum Analyzers. easyMap Tools 
provides features to:

• Convert maps and floor plans to a form suitable for use on Anritsu handheld spectrum analyzers

• Save maps by address, city, or browsing

• Insert GPS information into previously non-geo-referenced maps and set the levels of detail

• Convert bit maps to floor plans that can be displayed on the instrument

System Requirements 

• Microsoft® Operating Systems with:

• 1 GB of RAM

• 1 GB of available hard-disk space

• Microsoft .Net Framework 3.5 SP1

• Internet Connection (required for downloading maps)

Instruments Supported by easyMap Tools 

To identify the instruments supported by easyMap Tools, visit the Anritsu product page for Line Sweep Tools 
at: https://www.anritsu.com/en-us/test-measurement/products/emt

Figure 1-1. Coverage and Detail Map Screen

https://www.anritsu.com/en-us/test-measurement/products/emt


1-2 Installation General Information

1-2 PN: 10580-00440  Rev. C easyMap Tools UG

1-2 Installation
easyMap Tools is a software component of the Anritsu Tool Box download. Go to the Anritsu download library 
to install the latest Anritsu Tool Box software: 
https://www.anritsu.com/en-US/test-measurement/support/download.

• If you select the Full Installer, internet access is not required while running.

• If you select the Web Installer, internet access is required while running.

Select the installation program to start the download process and follow through the several installation 
screens as shown in Figure 1-2. 

During the installation process, an instruction screen will prompt you to choose the program to download. See 
Figure 1-3. Select easyMap Tools. Note that you may download more programs from the Anritsu Tool Box 
suite. The selected program(s) will be loaded to your system tray and show as shortcut icons on your desktop.      

Figure 1-2. Anritsu Tool Box Installation Process

Figure 1-3. Anritsu Toolbox Program Selection Screen

https://www.anritsu.com/en-US/test-measurement/support/downloads
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Chapter 2 — User Interface

2-1 Introduction
The easyMap Tools user interface screen display provides the utilities to prepare maps for use on Anritsu 
handheld spectrum analyzers. 

2-2 Menu Bar
The menu bar provides the File, Settings, and Help menus.

File Menu

The File menu is shown Figure 2-1.

Table 2-1. easyMap Tools User Interface

Title Description

1 Menu Bar Contains the File, Settings, and Help menus.

2 Map Type easyMaps uses MapQuest and NetToolKit

3 Save Map Saves the geo-referenced maps.

4 Detail Map Zoomed in view of the desired area.

5 Coverage Map
The total area covered by the geo-referenced map and red Panel 
Marker.

6 Progress Bar The status of the map tiles being captured and saved.

7 Address Input The area to be covered by the geo-referenced map.

Open Map: Opens two map types.
Opens (.map) Legacy Map Viewer. See Section  “Map File Viewer” on page 3-1.
Opens (.azm) Map File Viewer. See Section  “Map File Viewer” on page 3-1.

Open Image File (MAP): Opens an image file in the Legacy Map Viewer. Most 
image files will not contain GPS information. If boundaries need to be added to the 
image, go to Section  “Setting Image Map Boundaries” on page 3-5. A single 
geo-referenced map panel for legacy instruments. Set the desired field of view by 
changing the Coverage & Detail Status/Input. 

Open Image File (AZM): This is a pan and zoom map. Multiple map panels are 
saved for use in an instrument that allows for pan and zoom. Use Coverage Map to 
set the desired largest field of view and Detail Map to set the close up view.

Open KML Settings Editor : Opens KMLSettingsEditor to label KML points 
based on inequality operators and numeric values. See Section 3-3 “Open KML 
Settings Editor” on page 3-7.

Save Map: Saves a map set in Coverage Map and Detail Map. There are two 
types of maps can be saved using easyMap Tools:

Exit : Closes the easyMap Tools software.

Figure 2-1. File Menu

https://www.anritsu.com/en-us/test-measurement/products/emt
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Settings Menu

The Setting menu is shown in Figure 2-2.

Help Menu

The Help Menu is shown in Figure 2-3.

Set Map Format: Select an instrument map format: map for legacy instruments, 
.azm for the T and E series instruments.

Save Map and AZM: This saves maps in Map format and AZM format. 
Because the map is saved in both formats, the saving process will be longer 
than saving maps in either Map format or AZM format. 
Save AZM (Pan and Zoom): File format for the BTS Master, Spectrum 
Master, Cell Master and LMR Master.
Save MAP (legacy): File format used in legacy products.

Set Color Filter: Allows you to select a color filter when saving a map: 

None: No color filter applied
Grayscale: For viewing in bright daylight
High Contrast: Increases the black and white contrast of the default display. 
This setting is used for challenging viewing conditions.

Register MapQuest API Keys: Opens the MapQuest Register API Keys dialog to 
obtain and register OpenStreetMap API Key.

Configure Web Proxy: Opens the Web Proxy Configuration dialog to set the 
Proxy Server manually.

Configure Base Station Geo Location: Opens the Configure Base Station Geo 
Location window.

Figure 2-2. Settings Menu

Contents: Opens easyMap Tools Help.

Check for Updates: Checks the Anritsu Website for software updates.

About: easyMap Tools dialog that displays the software version and copyright 
date as shown below.

Figure 2-3. Help Menu
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Chapter 3 — Generating Maps

3-1 Introduction
easyMap Tools is a utility to create, view, and save maps. Geo-referenced saved files are viewed with Legacy 
Map Viewer .map files, or Map File Viewer .azm files.

3-2 Creating a Map
easyMap Tools uses NetToolKit and MapQuest as the map source vendors to create and save maps. 
OpenStreetMap map is provided by MapQuest and NetToolKit.

Map File Viewer

Map File Viewer allows you to view individual tiles with their geo-reference information that create the .azm 
file.

Before saving Open Map, use the “Settings Menu” on page 2-2 to set the color filter for the desired map 
appearance.

1. Click File menu.

2. Click Open Map... 

3. Select a file with the .azm extension. The map opens in the Map File Viewer.

Figure 3-1. Map File Viewer
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Legacy Map Viewer

The Legacy Map Viewer allows you to edit or add boundaries to a saved map.

Before using Open Map, use the “Settings Menu” on page 2-2 to set the color filter for the desired map 
appearance.

1. Click File menu.

2. Click Open Map... 

3. Select a file with the .map extension. The map opens in the Legacy Map Viewer.

4. Edit the map boundaries if desired.

Figure 3-2. Legacy Map Viewer
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Address Input

Enter the address of the location to be displayed in the Coverage Map and Detailed Map panels. Address 
Inputs can be entered as an address or GPS coordinates. There are two types of GPS coordinate inputs:

General Format

[Latitude][Space or Comma][Longitude]

• A minus sign (-) or a compass direction (N, E, S, W), can precede a latitude or longitude value. 

• North, East values are positive.

• South, West values are negative.

Examples:

• 37.4, -120.123

• N37.4, W120.123

• 37.4 -120.123

Secondary Format

[Latitude][Compass Direction][Longitude][Compass Direction]

Examples using Decimals:

• 38.959390N95.26548W

• 38S95.1E

Examples using Degree Minute Second (DMS) Notation:

• The symbols °, ’, ” are optional. If symbols are not used, Degree, Minute, and Second must be separated 
by a space.

• Degrees and minutes must be integers (no decimal).

• Seconds may have decimal digits.

• A single comma separating Latitude and Longitude is mandatory. Without this comma, many street 
addresses could incorrectly qualify as DMS notation.

• 38°57'33.804"N, 95°15'55.739"W

• S38°57'  33.804", E95 ° 15 ' 55 "

• 38 57 33.804 N, 95 15 55.739 W

Estimated Size

The value shown is an estimate of the file size of the map that will be saved. The larger the map sizes, the 
longer the saving process. Depending on the instrument used, large maps may need to reside on memory stick 
and connected to the instrument while interference mapping.

Saving Map

This button and the Save Map command in the File menu begin the process of saving a map. Press the Cancel 
button to stop the saving process. The larger the map sizes, the longer the saving process. Depending on the 
instrument used, large maps may need to reside on a memory stick and connected to the instrument while 
interference mapping. 

Note
If a Base Station Geo Location List file was added to the map, it will be saved with the map file at this 
time.
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Coverage map

The Coverage Map window has multiple functions when creating maps for legacy instruments, new 
instruments and image files.

• Legacy Instruments: Use this window for saving single map panels for legacy instruments. Set the 
desired field of view by changing the Coverage & Detail Status/Input. Use the mouse to drag the desired 
area into view.

• T and E Series Instruments: Use Coverage Map to set the desired largest field of view when saving an 
.azm map. A rectangle in this window represents the map displayed in the Detail Map window. Use the 
mouse to drag the desired area into view. 

Panel Marker

The red rectangle boundary over the map that designates the single map panel displayed in Detail Map.

Detail Map

Use this window panel to set a close-up field of view for the .azm map to be saved. This view will be the most 
detailed level of the azm. map. Set the desired field of view using the Pan & Zoom Tools. Pan is available for 
MapQuest only.

Setting Latitude and Longitude

The Edit Latitude and Longitude editor allows you to edit the latitude and longitude coordinates of the map in 
the Coverage Map window. Map boundaries in the Coverage Map window are dynamic. Dragging the map or 
moving to a new location changes the boundaries to the last area viewed. The units are in degrees.

Figure 3-3. Edit Latitude and Longitude
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Setting Image Map Boundaries 

1. Open the File Menu.

2. Click Open Image File... 

• The Open dialog opens and displays a list of image files.

3. Select the desired image file and press Open. 

• The image file is displayed in the Legacy Map Viewer.

4. Check the Outdoor Map box for maps created outdoors. Uncheck the Outdoor Map box for maps created 
indoors.

5. Press Edit Boundary Coordinates. 

• The Edit Latitude and Longitude dialog opens. 

6. Enter the latitude and longitude coordinates. 

• For acceptable types of coordinate inputs, refer to Section  “Address Input” on page 3-3.

7. Press Save. 

• The Edit Latitude and Longitude dialog closes.

8. Press Save Changes.

• The Save As dialog opens.

9. Enter a name for the map with new boundary coordinates. 

10. Press Save.

11. Press the close button at the top right corner of the Legacy Map Viewer dialog.

Coverage Map Setup

1. Enter the desired location’s address in the Address Input box. 

2. Press Go.

3. Set the depth of view for Coverage Map and Detail Map using the Pan and Zoom Tools within each map.

4. Center the desired location in Coverage Map by placing the mouse cursor in Coverage Map, holding down 
the left mouse button, then dragging the map.

5. Set the desired view of the Detail Map by moving the red Panel Marker in Coverage Map or grabbing and 
dragging Detail Map moving to the desired location. (MapQuest only)

6. Select Settings.

7. Select the Map Format.

8. Click one of the three save formats:

• Save MAP and AZM

• Save AZM (Pan and Zoom)

• Save MAP (legacy)

9. Select Color Filter.

10. Click one of the color filters or leave it at the default None:

• Grayscale

• High Contrast
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Coverage Map and Detail Map Setup

1. Enter the desired location’s address in the Address Input box. 

2. Press Go.

3. Set the depth of view for Coverage Map and Detail Map by using the Pan and Zoom Tools within each 
map. 

4. Center the desired location in Coverage Map. 

5. Place the mouse cursor on the desired location in Coverage Map holding down the left mouse button, and 
then it to the center of the map.

6. Center the desired location in Detail Map. (MapQuest only) 

7. Place the mouse cursor on the desired location in Detail Map, holding down the left mouse button, and 
then drag it to center of the map.

8. Save the map using one of the following methods. Both perform the same function.

• Save Map Button

• Save Map (with current Settings) (File menu command)

Note
If the size of the map to be saved is estimated to be greater than 20 MB, a warning dialog opens. To 
deactivate the dialog from opening in future map saves, check the box, “Hide this message in the 
future. (Cannot be re-enabled.).”
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3-3 Open KML Settings Editor
Allows the user to label stepping points of KML files downloaded from an Anritsu Handheld instruments based 
on inequality operators and numeric values. These labeled points can include mapping types RSSI, BER, 
MOFID and Mod Fid.

File Menu

Open: Click to open the directory folder containing previously saved KML files downloaded from an 
Anritsu Handheld instrument. Highlight and click the desired file to load into the KML Settings Editor.

Help Menu

Contents: Opens this topic page. 

Mapping Type

1. Press the list arrow button to list the map types available to KML including these – BER, RSSI, MOFID, 
and Mod Fid. 

2. Click the desired map type.

Stepping Points

1. Enter a numeric value in the second column or entry window for each of the five labels.

2. For each of the five labels, click the list button and select one of the four inequality operators.

3. Press the Update button to write the changes to the currently open KML file and saved.

Figure 3-4. KML Settings Editor
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Set Map Format

Set Map Format allows you to save a map format by selecting:

• Save MAP & AZM: This saves maps in Map format and AZM format. Because the map is saved in both 
formats, the saving process will be longer than saving maps in either Map format or AZM format. 

• Save AZM (Pan and Zoom): File format for the BTS Master, Spectrum Master, Cell Master and LMR 
Master.

• Save MAP (legacy): File format used in legacy products.

When you click Save Map command in the File menu or press the Save Map button on the easyMap Tools 
window, the map format selected will be used to create the map and then saved. 

Note
If a Base Station Geo Location List file was added to the map, it will be saved with the map file at this 
time.
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Chapter 4 — Configuring a Web Proxy

4-1 Web Proxy Configuration
To configure the Web Proxy:

1. Click Settings on the Menu Bar.

2. Click Configure Web Proxy to open the dialog shown below in Figure 4-1. 

3. Select one of the following options: 

• None: Automatic is the default setting. If you are not using a web proxy and problems occur, then 
select None.

• Automatic (uses Internet Explorer configuration): This is the default setting. Will automatically 
set the settings for the Web Proxy server.

• Manual: Some businesses require specific web proxy information. In this case, setup the Proxy 
Server Info and Credentials (optional) as required. Consult your IT when setting the web proxy 
manually.

Figure 4-1. Web Proxy Configuration Dialog
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4-2 Base Station Geo Location Configuration
Adding a geo location file to an AZM map file.

1. Click Configure Base Station Geo Location in the Settings menu to open the dialogFigure 4-2.

2. Click Browse button to load the desired Base Station Geo Location File into easyMap tools.

3. Check the box next to Save Base Station Data with AZM files. 

• When this box is checked the Base Station Geo Location List File is loaded into the AZM map file. 

Base Station Geo Location File

The purpose of a Base Station Geo Location File is to display a known base station in a geo-enabled map when 
running Interference Mapping on an Anritsu Handheld Instrument. 

The Base Station Geo Location File contains various information specific to a particular base station. This 
information includes:

• Type 

• Base station’s Latitude and Longitude

• Site Name and four additional labels that further describe the base station. 

These will be displayed in the first row of the file as column headers. “Type” color codes the base station icon 
and labels. Only four “Types” are supported – 0: red, 1: green, 2: blue and 3: black. 

The file format is tab-delimited also known as tab-separated values (TSV). “Site Name” and the four other 
column labels will be the button labels on the instrument. This TSV file can be created and edited with a 
simple text editor such as Notepad. Also, files created in a spreadsheet such as Excel need to be exported to the 
TSV file format. Below is an image of a sample TSV Base Station Geo Location file.

easyMap Tools imports the content of the file and places it into the correct map tile of the AZM file.

Figure 4-2. Configure Base Configuration Dialog

Note
There is a limit to the number of label characters on the instrument. “Site Name” will be truncated to 
18 characters and the three IDx labels will be truncated to 32 characters.

Figure 4-3. TSV Base Station Geo Location
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Using MapQuest:  An API key registration is required. The MapQuest zoom level control is restricted. 

Using NetToolKit:  Does not require an API key registration. The NetToolKit zoom level is not restricted.

Registering API Keys for MapQuest

API keys are obtained from MapQuest. To fully utilize easyMap, a Registration Key, also called an API key is 
required. Without an API key, easyMap allows you to create maps up to three zoom levels. API ley registration 
is required for unrestricted zoom levels. However, with an API key, easyMap allows you to create maps up to 
seven zoom levels. This allows great detail at the tightest zoom levels, yet can cover a large geographic area. 

The warning dialog shown in Figure 4-5 will pop up if the depth between Coverage Map and Detail Map is 
excessive. Click Capture at Trial Depth button that provides a capture maps with three levels of zoom.

MapQuest API Key

To obtain a MapQuest API Key, follow the list of instructions below.

1. Set up a MapQuest account if you don’t currently have one.

2. Go to:https://developer.mapquest.com/

3. Follow the MapQuest instructions to obtain an API key.

Entering the API Key

1. After obtaining the API key, enter it into easyMap.

2. Open easyMap v2.0 or above

3. Click Register API Keys in the Settings menu. The Register API Key dialog opens.

4. Enter the API key in the API Key box.

5. To check if the key entered is valid, press the Test API Key adjacent to the entry box. It may take up to 1 
hour to activate your API Key.

Download and save maps of several zoom levels. Maps can be large and can easily be over a Gigabyte, as each 
zoom level has twice the number of tiles (elemental maps) as the level above it.

Figure 4-4. Register API Keys Dialog

Figure 4-5. Map Capture Error Message

https://developer.mapquest.com/
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